MANAGING DIGITIZATION PROJECTS IN A SMALL MUSEUM

by

PENELOPE KELLY

A PROJECT

Presented to the Arts and Administration Program in partial fulfillment of the requirements for the degree of Master of Arts

March 2005
An Abstract of the Project of
Penelope Kelly for the degree of Master of Arts
in the Arts and Administration Program to be taken March 2005
Title: MANAGING DIGITIZATION PROJECTS IN A SMALL MUSEUM

The focus of this study was a review of major digitization projects to synthesize, extract, and understand basic practices and processes in order to simplify them into a form usable to the non-technically trained abilities of the staff in a small historical museum. The results of the study have been published in two forms: a printed manual and an electronic manual. The latter form has been published on the World Wide Web.
Acknowledgments

Foremost I wish to extend my sincere thanks to Professor Janice W. Rutherford for her guidance in the Arts and Administration Program and especially for her tactful and skilled assistance with the written report of my project.

I also express my appreciation and gratitude to Kathy Jensen, past Director of the Springfield Museum in Springfield, Oregon, and Springfield Museum Collection Manager, Estelle McCafferty. They unfailingly supported the digital projects I initiated at the Springfield Museum which are the practical basis of this project.

Lastly I wish to thank Pat French for the inestimable value of her contributions.
# TABLE OF CONTENTS

**INTRODUCTION** .................................................................................................................................................. 1
  - Purpose of the Study .......................................................................................................................... 1
  - Background Statement .................................................................................................................... 1
  - Statement of the Problem .............................................................................................................. 4
  - Significance ........................................................................................................................................... 5
  - Delimitations and Assumptions ...................................................................................................... 5
  - Definitions of Terms .......................................................................................................................... 6
  - Method ................................................................................................................................................... 7

**DIGITIZATION BASICS AS REVEALED IN THE LITERATURE** ................................................................. 8
  - Preparation ........................................................................................................................................ 10
  - Equipment .......................................................................................................................................... 14
  - The Scanning Process .................................................................................................................... 15
  - The Save Process ............................................................................................................................. 19
  - Storage ............................................................................................................................................... 21
  - Conclusion .......................................................................................................................................... 22

**MANAGING A DIGITIZATION PROJECT IN A SMALL MUSEUM** ............................................................ 23
  - The Manual ....................................................................................................................................... 25

**CONCLUSION** ............................................................................................................................................... 32

**APPENDIX A. UNIVERSITY OF OREGON SCANNING DIRECTIONS** ..................................................... 35

**APPENDIX B. SIMPLE STEP-BY-STEP SCANNING DIRECTIONS** .......................................................... 42

**APPENDIX C. THE EASY 1 2 3 MANUAL (ELECTRONIC FORM)** ............................................................ 45

**APPENDIX D. THE EASY 1 2 3 MANUAL (PRINTED FORM)** ................................................................. 46

**BIBLIOGRAPHY** .............................................................................................................................................. 47
Chapter 1

INTRODUCTION

Purpose of the Study
This study reviewed literature issued from digitization projects of historic photograph collections. I synthesized the literature from these projects and used the data as a basis for creating standards and guidelines for a simplified digitization project that could be undertaken and managed by a small museum. I have published my recommended standards and guidelines handbook in two forms: electronic via a website on the World Wide Web (Appendix C) and hardcopy (Appendix D).

Background Statement
Human beings have recorded their cultures in images for over 30,000 years (Kleiner and Tansey, 1996, p.26). Painted or carved, pictures are among the oldest forms of cultural documentation. Throughout the world, over the centuries, humans have expressed themselves in images and endeavored to expand their ability to make pictures. Finding new ways to make images is a ubiquitous human drive, unlimited by era or nationality. The 21st century has been called the Information Age, not least for the reason that we are constantly surrounded by the information contained in photographic images. Just as images record the cultural history of many eras and nations, the creation of photography was a collaboration of people from many nations.

Chinese archives from the 5th century B.C.E. record the principal idea of the camera. During the following centuries the original idea of the camera was expanded by an Arab scholar, an Italian scientist, and German mathematicians. In the 1800’s, a French
military man produced the first photograph, an Englishman patented a process which allowed multiple prints to be made from a single negative, and the American, George Eastman and his company, Kodak, manufactured the first consumer-friendly camera and photographic film in rolls (Leggat, 2000).

During the 1900’s, cameras continued to become less expensive and easier to operate. In the United States, cameras became standard fixtures at family gatherings, civic celebrations, and sporting events after 1950. Newspapers, once dominated by text and hand-drawn illustrations, became photograph rich. Photographs now record every aspect of life: work, recreation, fashion and war. There are photographs of pets, poets, and presidents. The affordable camera created an image revolution that made it possible for common people to record history.

A photograph is unique because it is a common object without intrinsic material value; nonetheless, it is highly valued because of its ability to preserve a passing moment for viewing in the future. Photographs are contemporary messages created to be historical documents.

As records of history, photographs, even personal family photographs, have broad cultural significance (Cornwall-Jones, 2001). Regardless of their original provenance, whether family photographs or professionally made pictures of renowned people or events, photographs preserve the images of what a culture believes and values. They are primary source documents, and as such, they are an important part of the document collection in all heritage institutions (Sandore, 2002). Even a very small community museum usually has a treasured photographic collection.
Before 1990 a photographic collection consisted of paper print photographs and assorted styles of negatives which were used to produce paper photographs; but because of the introduction of inexpensive personal computers, the definition of photography, and by extension, the possibilities open to curators of photographic collections, has evolved beyond printed paper photographs. The practice of digital photography and the process of digitization have entered the everyday world at many of the larger cultural heritage institutions including The Library of Congress, (Library of Congress 1999), Cornell University (Kenney, 2000) and a partnership of museums and libraries in the state of Colorado called the Colorado Digitization Project (Colorado Digitization Project, 2000).

Digitization means that materials are converted from formats that can be read by people (analog) to a format that can be read only by machines (digital). Flatbed scanners (stationary digital cameras), hand-held digital cameras, planetary cameras, and a number of other devices can be used in conjunction with computers to digitize cultural heritage materials. Any material including stone tablets, parchment manuscripts, books, or paper photographs can be photographed by a digital camera or scanner, storing the resulting image into digital format. (Sitts, 2000)

Libraries and museums have seen the digitization process as an exciting evolution in curatorial methods, because digital copy images of a museum’s printed photograph collection accomplish two important goals of cultural heritage institutions. These two goals are access and preservation (Library of Congress, 2000b). Printed photographs are inherently fragile, but the use of digital copies allows virtually unlimited access to
the pictorial information in a collection without damaging the original friable paper prints (O’Shea, 2002). Through the creation of digital copies the collection’s images are preserved against loss due to fading, floods, ravages of war, and other damages. Photographic collections have been a common choice for digitization projects because of the benefits of increased access and protection/preservation of the photographs (L’Homme, 1999, p14).

**Statement of the Problem**

World-wide, the largest libraries and museums have been the first cultural institutions to initiate digitization projects because they are able to bear the high costs associated with procuring the necessary equipment and employing trained personnel. In most cases the actual digitization process has been contracted to private vendors. These digitization projects are often well documented and published in order to be used as guides to the digitization efforts of other institutions. Documentation of many large digitization projects is available in electronic form on the Internet. Institutions which have published online documentation include The Library of Congress, The University of British Columbia, The University of California at Berkley, Arizona State Library, Archives and Public Records.

Unfortunately, small museums that might wish to follow the lead of large digitizing institutions are usually not able to acquire the large expensive equipment or the technically oriented staff resources necessary to follow the complicated procedures described in large-scale digitization projects (IMLS Public Report, 2002). The expense of large digital projects has been intimidating to smaller institutions who have not understood that the huge size of major collections such as those of The Library of
Congress or Cornell University involved costs which need not be borne by small institutions. And, too, the language used in describing procedures of large digitization projects assumes a level of technological knowledge which the staff of small museums usually do not possess.

The goal of my project is to discuss several definitive digitization projects, summarize their published procedures, and simplify the procedures into guidelines which are accessible to a typical small museum that might not possess the technical knowledge or equipment of the larger institutions.

**Significance**

This study reviews several large projects and converts their recommendations into a form that fits the needs of small museums. The result of this research, the subsequent handbook, will make it possible for the staff of a typical small museum to easily understand the process of digitization and manage their digitization projects. Small museums will be able to provide expanded access to the museum’s photograph collection through presentation of their photographs in electronic exhibits or on the World Wide Web. Digitization of their photographic collections can also provide higher visibility for small cultural heritage institutions, as well as provide additional sources of income.

**Delimitations and Assumptions**

This project neither attempts to persuade the reader to undertake a digital project nor attempts to point out all of the possible uses of digital images. This project does not
include how to construct a Meta-database or discuss copyright issues. Specific software and hardware is not recommended.

This project assumes that there is information in each of the studied projects which is transferable to the simplified needs of small museums, and that small museums need this information. A third assumption is that whoever does the digitization for the individual museum will have access and basic knowledge to operate a computer, image manipulation software, and a flatbed scanner.

Definitions of Terms

Archival Image: An image meant to have lasting utility. An archival digital image is often called the Master image. Generally the Archival image is of higher quality than the digital image delivered to the user.

CD-ROM: Compact Disc Read-Only Memory. A form of write-once, disc-based, random-access data storage, usually distributed as a publication which may include sound, image, and text files. At present CD-ROMs are capable of holding approximately 700 megabytes of data.

Digital Camera: An electronic camera that directly captures a digital image without the use of film.

Digitization: The process of creating a digital representation or image of an original object through scanning or digital photography.
Meta-database: A searchable compilation of digital images.
Scanner: A device for capturing a digital image.

TIFF: Tagged Image File Format is an image file format used for the storage of high-quality images.

World Wide Web: WWW. An interconnected network of electronic hypermedia documents available on the Internet. WWW documents are marked up in Hypertext Markup Language. Cross references between documents are recorded in the form of URLs (Universal Resource Locator).

**Method**

This study is a qualitative literature review for content. I studied the literature from photography digitization projects and did a personal, qualitative interpretation of basic elements of project design and procedures within each of the projects. I searched for basic commonality which suggested fundamental technical and administrative procedures. The projects I synthesized address many complicated procedures large libraries and museums need to consider when making digital images from their collections. These complicated procedures however are unlikely to be required in the digitalization projects of small museums. I used my knowledge of small museum practices and resources to determine what information from the large projects is transferable to small museums.
Chapter 2

DIGITIZATION BASICS AS REVEALED IN THE LITERATURE

If you are invited to a birthday party you might decide to bring a camera and take pictures of the celebration. Unless you are a professional photographer you might not be interested in knowing the chemical composition of photographic film: how silver-halide crystals are arranged in a gelatin emulsion. You might not care to understand color theory, focusing screens, procedures for grinding lens, telephoto configuration, diverging ray theory, the position of the oblique muscles and their tough fibrous sclerotic coat in the eyeball, or much of anything about the physiology of sight. (Macaulay, 1988, pp. 210-217) But, even if you are not interested it knowing any of these things you can still take wonderful pictures at the birthday party if you know the basics of photography.

The same can be said of undertaking photograph digitization in small museums. Written documentation about the digitization projects of large museums and libraries devotes entire chapters to interesting complexities: data management theory and esoteric technical explanations. Navigating the labyrinthine details of these documents
can be overwhelming. Fortunately it is not necessary to know about or understand most of the information covered in the descriptions of large projects in order to digitize a photography collection in a small museum, but the large digital projects can help with the basics of a small project in the same way that a definitive photography manual covers the basics of photography for the beginner.

What are the basics of digitizing photographs? If we go back to the analogy of the birthday party it is easy to illustrate the essentials. Instead of photographing party guests with a camera, the digitization staff is going to take pictures of photographs with a stationary camera called a flatbed scanner. Instead of sending the film out to be developed by professionals, a scanner will be connected to a computer that has image-reading software.

A simple record book about the ‘party’ will be used to write down and save the ‘names’ of the scanned photographs on a form describing scanned data, much like saving a guest list. And finally the new digital images will be saved on CD-ROMS. The basics of a digitization project, broken down into categories are: preparing, acquiring the necessary equipment, completing the scanning process, saving, and storing.
Preparation

“The success of digital projects hinges not on expensive technology, but rather on sound project planning,” according to the Illinois Digitization Institute (Jones, 2001).

Determining how much of a photography collection will be digitized is often the first planning decision. “Most museums take a ‘project’ approach to digitization, while others systematically digitize all or large parts of their collections. Whichever approach you adopt, planning is critical to the success of the project,” advises the Canadian Heritage Information Network (CHIN) (2004, planning.html, para. 1). This was the only digitization resource I found which targeted small museums. The Network’s digitization manual is titled Capture Your Collections - Small Museum Version (Canadian Heritage Information Network, 2004).

The reference to “most museums” in the CHIN quote should be read as “most large museums.” For example, the imaging efforts of Cornell University Library, an institution that pioneered digitization in the 1990s, were project based (Kenney, 2000), but small museums, with their significantly smaller collections, may find it easier to digitize their whole photography collection sequentially. Taking one portion at a time, as in a project, may not be the best approach for digital ‘beginners’. The advantage to a systematic digitization of the entire collection is that it can be done a few photographs
at a time, even by different volunteers, as time allows. Digitizing serially, such as by accession number, which is the unique number assigned to each item taken into a museum’s collection, will make the progress of the project technically understandable and easy to track. Simplicity is a paramount virtue of successful digitization projects in small museums, and thoughtful preparation is vital to insure that the entire process is as simple and straightforward as possible.

The next important step of the preparation phase is to look over the collection to be sure all of the photographs are stored in order so they can be pulled sequentially when it is time for their scanning. It may be necessary to scan the photographs ‘out of order,’ but the process will be less apt to get muddled if the photographs are in order before beginning the project. Reviewing the order of the collection will also allow the staff to identify duplicate copies of photographs that might be filed under different numbers (Denver Public Library, FAQ, Item 5, 2004).

Cornell University Library, like the Canadian Heritage Information Network, has produced a digitization manual, titled *Moving Theory into Practice* (Kenney, 2000). Unlike the CHIN manual, the Cornell tutorial is a guide for large digitization projects and is correspondingly complicated. For example, the tutorial thoroughly explains
technically difficult subjects such as bit-depth (Kenney, 2000, Basic Terminology, Bit Depth) and how to calculate resolution by pixel dimensions (Kenney, 2000, Basic Terminology, Pixel Dimensions). There are however, suggestions which are useful as basic guidelines in a small project, such as the advice to involve technical staff early and often in planning discussions and the warning that it is especially important to keep lines of communication open between technical staff and project staff during the planning stage (Kenney, 2000, Chapter 9). In a small museum, technical staff and project staff are most often the same people, but the Cornell advice emphasizes the importance of all staff knowing about the digitization project and knowing that they are welcome to contribute their enthusiasm and labor to the project.

In my experience, museum volunteers welcome participating in digitization projects because the projects give them the opportunity to do ‘real work’. The planning stage will allow everyone a chance to discuss how the digitization project fits into the museum’s mission and to understand the benefits digital images will provide to the museum’s staff and users. The Colorado Digitization Project documentation advises that the planning stage is the time to decide who will be responsible for different aspects of the project and to query the staff for levels of technical expertise or interest in technical training (Colorado Digitization Project, 2000). I believe that a small museum
using my recommendations to simplify their procedures should emphasize that the project is carefully organized so that its technology can be easily learned and so that it is open to all.

The process of writing the scanning instructions, and developing procedure forms and guidelines for the project are important parts of the preparation stage. The Illinois State Library’s digitization guide, *Planning for Digital Imagine Projects* (White, 2003, Planning, para.1) addresses the importance of developing the forms during the preparation stage. None of the literature I reviewed gave examples of simple forms, but I developed my own from my digitizing experience at the Springfield Museum in Springfield, Oregon. Digitization projects can use non-technically oriented personnel if they can be guided by simple forms with blanks where the volunteer enters the information that museum staff wishes to have recorded. As an example of the difference between forms developed for computer knowledgeable staff and the type of simplified instruction form which non-technically oriented staff need, I have included in Appendix A step-by-step scanning instructions that the University of Oregon has published on its library website (Hixson, 2004). Its complicated instructions can be compared to the simplified step-by-step instructions in the document entitled Simple Step-by-Step, included in Appendix B.
It is important to have clearly written and straightforward instructions for all aspects of the project. Guidelines and all other documents related to the project should be printed and placed in a digitization notebook. The notebook should be kept where it will be easy to find, perhaps by the scanning equipment. The instructions will cover how to operate the scanner, the computer, and the imaging software in step-by-step detail (See Appendix B). Also, there should be a statement in the digitization notebook that clearly states the digitization standards all staff are expected to follow. The Best Practice guides of the large museums and libraries, including the Canadian Museum of Civilization, the Library of Congress, and the University of California at Berkeley Library stress, by example, the importance of written standards. Small museums will find a statement of standards well worth the time it takes to develop it, because following these standards is the key to allowing non-technically oriented staff to create a high quality digital collection.

**Equipment**

The equipment needed in a small digitization project includes a computer with photo imaging software, a scanner, and a CD maker. “Flatbed scanners will perform well for small digitization efforts of under 5,000 documents. Capture software may be simple
Windows or MAC based applications for small local collections,” advises the Washington State Library (2004, Hardware & Software Requirements, para. 2). “The software that runs the scanner is also important. It should be straightforward to use.” Higher Education Digitisation Service (HEDS) (Criddle, 2003, Choosing scanning equipment, para. 11)

My review of the literature failed to find any recommendations for specific brands of equipment. The important aspects of the equipment are that it be affordable and uncomplicated, and that the operators have step-by-step instructions on how to use the equipment for each part of the process.

**The Scanning Process**

Scanning is a lengthy process and takes staff time that will be used most effectively if each photograph needs to be scanned only once. The goal is to produce an information rich image, which is called either the archive copy or the master image. “From the master images, surrogate images, or working copies, can be produced for a variety of purposes without having to repeat the image capture process” (Canadian Heritage Information Network, 2004, Managing Images).
All of the literature I reviewed agreed that the actual scanning of photographs is not complicated. The physical operation is simple: one places the photograph face down on the bed of the scanner and presses the ‘go’ button. The complications of scanning are in deciding the settings that will determine how the scanner will copy the photograph. The settings that are available on a scanner usually include scale alternatives, different resolution possibilities, output color choices, and, sometimes, options called filters that will change the digital copy so that it is different in some way from the original photograph. A typical filter is the ‘blur’ filter. The function of this filter is to digitally ‘erase’ some types of scratches from the copy that are present on the original photograph.

Most experts discourage the use of filters because image manipulation destroys authenticity. Digitization should produce a master copy that faithfully reproduces the original photograph’s color and condition. The term ‘editing’ in the following quote refers to the use of image changing filters. Roy Tennant of the Digital Library at the University of California at Berkeley writes, “The purpose of a master file is to capture as much information as is possible or practical regarding an item exactly as it currently
appears and save it with no information loss from compression or editing” (Tennant, 1999, p. 28).

“No information loss” means that an uncompressed file format such as TIFF should be used when saving the master copy. TIFF stands for Tagged Image File Format. This is an image file format used extensively for the storage of high-quality images. There will be more on compression and file format in the next section, “The Save Process.”

Choosing to increase the scale of the master copy is not the same as using a filter, changing scale does not make the digital copy look different than the original. The Library of Congress often scales copies up when the digital copy is likely to be used to make a significantly enlarged print such as those made for an exhibit. For example, The Library of Congress’ collection of Ansel Adams’s Manzanar photos, which were originally 10 inches by 14 inches, were digitized at a minimum enlargement of 200% to insure fidelity in highly enlarged paper prints (Library of Congress, 2000a).

Another reason to enlarge scale is to compensate for the smallness of the original. Small photographs can be difficult for researchers to use. Digital copies can be scaled up at
the scanner to enhance the details present in the original photograph so they are easy to see. Increasing resolution settings will do the same thing by allowing well-defined enlargements, but it is more complicated to calculate the appropriate resolution than it is to increase the scale. If scale is changed, one must document the scale change, the size of the digital copy, and the original photo size. The Digital Library Federation states, “The standards must be documented so that the person who wants to use the digital images years from now will have measurements to return to” (Colet, 2000).

Resolution relates to the amount of detail in an image. Resolution settings recommendations vary within the literature. Some portions of the Library of Congress’ digital photograph collection titled “American Memory” were scanned at 200 dots per inch (dpi), some at 300 dpi, and the majority at 600 dpi (Library of Congress, 2000b). To determine the ‘correct’ resolution setting for a digital photograph collection, each heritage institution will have to determine whether its archived images will be used primarily by local or international researchers. Local researchers will probably be satisfied with digital photographs at 300 dpi because their main interest is the image content. A higher resolution of 600 dpi will be necessary for the level of detail needed by international scholars because international scholars will be interested in the surface,
paper, and printing process of photographs which will be evident at 600 dpi. These details are usually not required by local researchers. However, if they are required, the original photograph is available to the local researcher for on site inspection. A collection should be scanned using the resolution that will fit the requirements of the average user. Whatever the resolution of the general collection, if an exceptional need arises such as the requirement to have a higher resolution copy of a particular photograph or of a small group of photographs, the originals are easily re-scanned.

**The Save Process**

All of the literature I reviewed recommended saving archive images as uncompressed TIFF images because TIFF is a public domain format which can be used by all common image processors. Compression means that a certain amount of information needs to be eliminated in order to reduce (compress) the size of the file. The resulting image, upon re-opening, will not be as detailed as the original digital image and each time the image is ‘saved’ it will be compressed again and lose more detail information. Compression is used to make an image file smaller. Compression is appropriate when size, rather than quality, is of utmost importance.
This process is easy to understand if we imagine a living room full of furniture, books, rugs, and pictures. If you wanted to store the contents ‘as is’ (which would be analogous to ‘uncompressed’) you would need a 30 by 30 foot storage area. But, if you wanted to put the contents into a smaller area (‘compressed’), you would have to throw away some of the items. Imagine that occasionally you wanted to look at the things you had in storage. When you opened up the uncompressed 30 by 30 foot area, all of your belongings would be there, just the same, each time. However, each time you looked in the compressed area, you would have to throw away more of your furnishings before you could shut the door again. Furthermore, these thrown away items would not be recoverable. Over time, the value of your belongings in compressed storage would diminish substantially. It would be difficult to overemphasis this fundamental point in digitizing a photograph collection: when you save a master digital image you want it to remain the duplicate of the original photograph and for this reason you do not compress the digital image.

The last phase of the save process is recording the ‘name’ of the photograph along with whatever data about the digital copy your institution wants to document in a digitization notebook. In my digitization guide, I have recommended that museums
name the digital copy the same name as their original photograph followed by the TIFF designation. For example, the Springfield Museum identifies its photographs by accession number. If a photograph accession number is 1979.001.012, then its digital duplicate is saved as 1979.001.012.tif.

**Storage**

The final phase in many digitization projects is the storage of the archive image. To store images the small museum will need a computer that is capable of making CDs from the digital images it captures or an auxiliary piece of equipment capable of making CDs. As with all other portions of the project, clear detailed instructions on how to operate the CD making hardware and software should be provided for all digitization staff.

All of the literature I reviewed recommended CD-ROM storage. The Colorado Digitization Project Toolbox Glossary states: “Archival images are usually kept off-line on a cheaper storage medium such as CD-ROM or magnetic tape” (Colorado Digitization Project, 2001b, rsrc_glossary.html). The virtues of CD-ROMS for storing archival images are that CD-ROMs are available from many sources, they are
inexpensive to buy, they are easy to use, and they take up little physical storage space. Another attribute of CD-ROMs that makes them ideal for small museum use is that a few images at a time can be added to them, until the CD is full. For all of these reasons, CD-ROMs are an outstanding choice for small museums as well as for large institutions. The Library of Congress uses CD-ROMS to store the American Memory collection. “The master TIFFs have been copied onto CDs and duplicated so that one set can be stored off-site” (Library of Congress, 2000c, /ndlpcoop/ichihtml/build.html).

Conclusion

The digitization literature supported my research assumption that digitization consists of a few basic processes and elements which are easily duplicated on a smaller scale that is appropriate for small museums. The basic elements in any digitization process are transferable to a small museum project. Complicated language and complex technical explanations can be simplified into a process description which non-technically oriented museum staff can understand.
Chapter 3

MANAGING A DIGITIZATION PROJECT IN A SMALL MUSEUM

I entered the Arts and Administration program at the University of Oregon knowing my educational goal: I wanted to learn how I could contribute to helping museums go ‘online’ with images of their collections. My interest in digital technology was prompted by a recognition of the possibilities this media offered in its ability to increase access to collections and enhance research opportunities to those who could not visit the museums. I was, and continue to be, intrigued by the opportunities in distance learning which digitization makes possible. During my time in the Arts and Administration program the number and scope of on-line digital collections has grown each year as heritage institutions have responded to the eager interest of their internet audiences (Bishoff, 2001). Digital publications such as on-line exhibits and CD-ROM based electronic exhibits are a growing part of the educational presentations of many large cultural heritage institutions including the Metropolitan Museum of New York, The Louvre, The Library of Congress, and The British Museum.

Originally I wanted to work at a large museum because of their leadership in digitization, but a pivotal point in my educational focus came when I learned that 75% of the museums in the United States are small museums (IMLS, 2002). I realized that I
never heard or read about the digitization projects of small museums. As time went on, I began to suspect that lack of information about projects reflected a lack of projects. This condition bothered me because it seemed such a terrible waste of the research resources being held in the collections of small museums. I was sure that digitization was within the reach of anyone, and I became intrigued and excited about working on a digitization project to try out my theory. I contacted the director of a local museum and asked if I could intern at her museum. This initial contact unfolded into a three-year, personally and professionally fulfilling collaboration with the director and the collection manager at the Springfield Museum in Springfield, Oregon. While I have worked with the museum, I have produced a CD-ROM electronic exhibit on early logging days in Springfield, and an electronic photo-album on the same subject. Also I began a volunteer staffed project to digitize the entire photograph collection, developed an education program for small museum digitization programs, and taught volunteers how to teach other volunteers to digitize so that the program can go on even through staff changes.

The Springfield Museum had not been involved with a digital project before I proposed one, but the director was very receptive to my project suggestions. Her enthusiastic support allowed me to experiment and explore my ideas. I digitized the photographs for the first project by myself, but then I realized that I could make a more valuable contribution to the museum if I taught someone at the museum how to do what I had
done. The collection manager was the ideal candidate because she was very supportive of the first digital project, she wanted to help me, she was eager to learn, and demographically she is an ‘average volunteer.’ That is, she is over 60, had never used a computer, and is an enthusiastic lifelong learner who believes passionately in the value of her museum’s mission in the community (Fox, 2001). Each of these attributes was important to me as I learned how to teach her the computer technology necessary to digitize photographs. Her lack of knowledge forced me to think very carefully about how to develop a manual that was basic, but information rich. My model in developing digitization instructions was a cooking recipe because recipes are succinct, unambiguous, and not laden with confusing choices. They are explicit guidance for a person who has never cooked a particular dish before. I realized success depended upon developing a simple manual that would become the equivalent of an in-house digitization instructor and computer teacher.

The Manual

The title of the manual is *The Easy 1 2 3 Guide to Digitization in Small Museums*. The title’s suggestion of simplicity is meant to reassure non-technically oriented staff that the manual will make a complicated process easy to understand.

The Introduction chapter carries forward the theme of achievable success. “Follow this guide and your museum can digitize your collection with a minimum of funds and
technically trained staff. The plan in this booklet is simple but powerful. It will help you achieve your own successful digitalization project.”

The second chapter, “Equipment,” includes, along with the necessary software and hardware, instructions on how to make a digitization notebook. The notebook contains the forms I developed which guide the digitization project. The forms are in the manual in the chapter, “Forms.” The equipment chapter also contains instructions on how to make it easy for volunteers to use the computer and find the digitization software.

The Forms chapter is the heart of the manual. I developed the forms with two purposes in mind: the first was to record data about the digitization of each photo, and the second was to insure the volunteer’s ability to carry on without me as the in-house computer ‘expert’. The digitization forms establish best practices and standards that insure high quality digital images. I stress the importance of not deviating from the standards: “The Scanning Procedures are not arbitrary and should not be changed.”

The Preparation chapter contains administrative instructions and practical suggestions on how the digitization manager can help her or his staff to be successful through attention to overall philosophy: “Talk to your staff about the digitization project and ask for interested volunteers. Stress that they don’t need to be computer experts to help
with the project.” The chapter emphasizes attention to details: “Print out the forms in a size large enough for everyone associated with your project to read easily.”

The Scan chapter contains practical information such as how to set up the scanning area: “Place the Step-by-Step instructions and the Scanning Procedures at the beginning of the record book. Go over the contents with each team member. Show them the forms and answer questions about the process. Tell them it is ‘Okay’ to take the Step-by-Step sheet out of the record book and set it by the computer for reference.” The Scan chapter also gives instructions on how to make a high quality archival image: “Set the scanner’s default settings to Full Color, 300 dpi resolution, 100% scale,” and explanations on why particular settings are given: “Scan all photographs in Full Color mode, .. yes, even black & white photographs. Why? Details can be ‘teased’ from color scans and one setting for all prints keeps the process simple.”

Throughout the manual, the tone is conversational and informal. I have used ordinary language and omitted technical ‘jargon’.

The Save chapter gives practical instructions such as, “Save the digital image as an Unaltered, Uncompressed TIFF. (If you are curious, TIFF is an acronym for Tag(ged) Image File Format)” as well as cautionary statements, “Remember - Do not make any changes to the Master other than scale and/or ‘rotation.’ For example, do not change
contrast levels, ‘touch-up’ blemishes, or make any type of color correction on the Master.”

The Store chapter talks about how to use CD-ROMs. An advantage of CD-ROMs for storage is that the digital images cannot be accidentally erased or changed. Another advantage of this type of storage is that it overcomes the objection to a digitization project that the images will take up too much space on a museum’s computer because the images are constantly transferred away from the computer.

The next chapter is Utility. In this chapter I have given suggestions about the future uses of the digital images. “Tiff images can be used for printing on a variety of surfaces including clothing, stationery, postcards, and calendars. Many templates are available. Check on-line or at your local stationery store for ideas for using your images to promote your museum or to create unique items for your museum’s gift store.”

In this chapter I also invite users of the manual to contact me. “Would you like more ideas on how to use your TIFF images? Write to me at pkelly@efn.org. Tell me about your needs and ideas. I will be happy to help you ‘brainstorm’.“ I included this invitation because digitization is easier for non-technically oriented people if they can have access to someone who knows what they are going through. I have been teaching people how to use computers for over 11 years and I know there will be questions. I
have intentionally written my manual with minimal detail in order not to confuse people with explanations and choices they are not knowledgeable enough to make.

The future of digitization projects at Springfield Museum is positive. The museum’s interest has progressed to the point that it has invested in digitizing equipment. When I started working at the museum I had to bring my own equipment. I had a laptop Macintosh computer and a flat-bed scanner which I carried back and forth to the museum. Recently the museum bought a computer, a scanner and a CD burner to use for digitization projects. The collection manager has bought a home computer for herself and is presently teaching other museum volunteers how to digitize photographs. She and I made a presentation about the Springfield digitization project at the annual meeting of the Oregon Museum Association in October, 2004. We could confidently tell audience members that, regardless of their level of computer literacy, they could follow my manual and succeed because it was written from successful real experiences in a real museum with a miniscule budget and all volunteer staff. I have talked about digitization to volunteers and paid staff from a dozen small museums. Over and over I have heard them say they were inhibited to explore digital projects because they believed that digitization must be “very expensive” and “technically difficult.” They believed that the process was beyond their resources and abilities. This circumstance is unlikely to change without a new approach because, not only are the
reports and jargon of the published projects too complicated to be useful to small museums, but the initial impediment is the difficulty of finding the reports.

Volunteers usually work only a few hours at a time. This is insufficient time to do a blind web search for digitization projects that they could use to guide their own project. Such a search is prohibitively time consuming for a museum volunteer. The search process from a volunteer’s point of view interested me, so I started doing searches of the on-line literature about digitization. I used the Google search engine because it is the best known and I thought a non-technically oriented volunteer might be likely to use it.

Photography collections are the type of collection that is most often digitized and, in my experience, even non-technically orientated museum people know this. Consequently I searched Google using the term "how to digitize photographs." The search return was 118,000 websites. Reading through the web pages of the sites that were listed on the first 2 pages of the 118,000 sites report took me 3 hours. In all, I looked online for digitization project help for 4 hours, a typical volunteer shift at the Springfield Museum, Springfield, Oregon.

I continued the on-line search every day for a week. The amount of time it took to search through page after page of useless information in order to find useful advice was
enough to cause me to believe that the typical volunteer would not stick with this formidable quest.

I concluded that writing an easy to understand manual was only part of the digitization solution for small museums. The full solution was to write the manual, make access to it easy, and then TELL people about it. Originally I had written a paper manual, but I found that reaching out to small museums in printed form was difficult and ineffective because distribution was problematic. To facilitate access to the information, I decided to change my original paper manual into an electronic manual that I have published on a web page (http://www.efn.org/~pkelly/). My next step is to publicize my electronic manual. I will contact each small museum in Oregon by e-mail and send an informative announcement about the contents and the web page address.
This study reviewed literature issued from large digitization projects of historical photograph collections and synthesized the data to create standards and guidelines for a simplified digitization project that is within the capabilities of the staff at a small museum. This study has shown that producing a simplified digitization project requires acquiring a few basic pieces of equipment and learning a few basic processes. My project has generated a manual which explains the equipment needs and the basic digitization processes in easy to understand language. The manual can be used by non-technically oriented museum staff to produce quality digital reproductions of print photographs.

Extending digitization ability to small museums is important because of the extensive image resources held in small museums. Access to historical photograph collections of small museums is currently limited but digitization projects can furnish accessibility to a museum’s photograph collection because the valuable and fragile original documents
can be digitally reproduced and distributed to more people than could safely handle the printed photographs.

Opportunities for further study include the preparation and administration of surveys to determine the needs of small museums that want to digitize photograph collections. Regional training and equipment centers are a possible need. Another area to explore is the management of partnership arrangements between museums and community resources that might provide technical expertise and equipment.

Internships of technically trained museum studies students working in small museums have been under utilized. Partnerships between university students and small museums are a natural association for the benefit of the student and the museum. The museum would gain technical supervision of digitization projects and the student would gain professional experience working in the culture of a small museum.

I suggest that museum studies students be offered formal training in digitization project management and that workshops be offered which teach digitization theory, process
basics and adult education strategies. The construction of electronic exhibits is a natural use of digitization images, and training in how to use digitized pictures would be a valuable contribution to a museum oriented arts and administration program.

Digitization has been recognized throughout the museum world as an effective way for cultural institutions to offer access to their collections. Although digitization projects at large institutions are often expensive and complicated my research has shown that digitization is within the capabilities of small museums. Digitization of historical photographs and the distribution of digital images is a practical way for small museums to extend their presence and mission within their communities.
APPENDIX A. UNIVERSITY OF OREGON SCANNING DIRECTIONS
SILVERFAST SCANNING INSTRUCTIONS
FOR MOORHOUSE PROJECT
dcb, rev. nsg 7/8/03, rev. dcb 9/18/03, rev. dcb 03/10/04

BEFORE YOU BEGIN: Turn on UMAX scanner. Turn on computer. Open Microsoft Excel. Open Scanning Log spreadsheet, which is located in the Scanning Work folder.

1. Clean the scanner bed with a blast of canned air. Use an optical cloth to remove any persistent debris.

2. Open Adobe Photoshop.
   a. File > Import > Silverfast (UMAX)  [note: do not use Silverfast UMAX (32-bit). It is the demo version]
   b. Silverfast Windows will open with a previously pre-scanned image in the preview window
      [If upon opening Silverfast, you get a message saying that the scanner was not found or was not available, then quit Photoshop, make sure the scanner is turned on and restart the computer. When the computer restarts, try step 1 again. If problem persists, turn off computer and scanner. Wait approx. 30 seconds. Turn on scanner. Wait until blinking lights stops and all three lights on the scanner front are solidly lit. Turn on computer and launch Photoshop.]

3. Select parameters in GENERAL pane of SilverfastAI window.
   a. scan mode > normal
   b. Original > choose Transparency or Reflective according to media being scanned.
      [color calibration and the light source is specific to what is chosen for “Original” setting]
   c. Positive/Negative > Use “positive” setting unless scanning color negative stock that would need an orange dye-layer compensation for proper color balancing. NOTE: IT8 calibration does not apply to the Negative setting, which is why we are using Transparency for the Moorhouse Project.
   d. Frame-set > leave as is, should say ‘save’
   e. In the FRAME pane of SilverfastAI window: For Moorhouse choose Scan Type > 42 - 24 Bit Colour
For full 48-bit workflow, choose 48-bit. For 24-bit workflow, choose 48-bit, and convert to 24-bit in Photoshop.

4. Select negative and enter metadata
   a. Enter the title on the envelope in the Scanning Log. Enter the scan date in the form: yyyy-mm-dd.

5. PRESCAN
   a. Visually inspect the original negative, on a light table if possible, with the emulsion side up.
   b. Notice the physical condition of the glass plate and the emulsion, including chips and cracks in the glass, scratches and flaking in the emulsion, and discoloration of the emulsion. Note the condition of the negative in the Scanning Log, choosing terms from the Source Condition vocabulary.
   c. Notice any areas that are extremely dark, and any that are extremely thin (or clear). The familiarity you gain from this glance will inform future scanning decisions.
   d. Clean the surfaces of the glass plate with a blast of canned air. Make sure to only use short bursts of air to prevent propellant release (if propellant hits the negative, wait for the area to warm and evaporate. If residue is observed after the area evaporates, use a clean optical cloth to gently wipe off this residue). Place original on the scanner bed, **emulsion side facing down***. Align original with edges of scanner bed (*if you are using the Microtech 1800 in Exhibit Services, place negative on the universal glass transparency tray at base of scanner with **emulsion side facing up**)
   e. Press the ALT key. Notice that Silverfast’s option button switches to say ‘reset’. Hold down the ALT key and click on the ‘reset’ button. This resets any manipulations made for previous scans. (on Mac OSX Silverfast uses a button with a curved arrow icon, located at the bottom left of the general Silverfast AI pane as a reset button. There is no need to hold the option key on Mac OSX to activate this reset button.)
   f. Click ‘Pre-scan’ at the bottom left of the SILVEFAST AI control window. Wait for pre-scan.
g. Draw selection marquee around the pre-scanned object. Selection frame should be JUST INSIDE of the object to be scanned, excluding any background region of the scanner.

h. If the edges of the original are not parallel with the selection marquee, adjust the original on the scanner bed and redo pre-scan. Repeat until the selection marquee is parallel to the edges of the original [NOTE: if the original is not perfectly rectangular, all edges will obviously never be parallel to all edges of the marquee. In such a case, align either the top or bottom edge of the scan.]

6. CHECK HISTOGRAM
   a. Click on the Histogram button (icon looks like a bar graph) eventually the histogram will make sense. Look at it occasionally as you make changes and observe what happens to the histogram as a result. Click CANCEL button to close the ‘histogram dialogue’ window without making changes.

7. Set the HIGHLIGHT point
   a. Find the “show brightest or darkest point” button (lowest button in the pre-scan window. It is an elongated rectangle whose top half is white (for highlights) and lower half is black (for shadows).
   b. Click and hold down the mouse button while over the highlight (white) half of this button. The red crosshairs indicate the brightest spot in within the scan frame. If the crosshairs appear over an area that is not part of the PHOTOGRAPHIC IMAGE (e.g. a scratch, lettering etched into the emulsion, a crack, a clear glass area containing no information), temporarily adjust the selection marquee to EXCLUDE these areas. If the crosshairs are over actual photographic image area, go to step 7c.
   c. Holding the SHIFT key, click on the white/highlight portion of the button. A smaller white crosshair appears, and a ‘densitometer pipette’ window appears. This marks the brightest highlight region of the image you are scanning that still contains image data.
d. Recalling the visual inspection completed in step 5a, and noting the pre-scan on the screen before you, second-guess the automatic highlight that you selected in 7c. If any area of the image seems lighter than the region selected, roll the mouse pointer over that region.

[Look at the ‘Densitometer’ panel and notice that the small square APERTURE moves over a magnified area of where your mouse is. The six numbers that move in the densitometer window reflect the darkness/lightness of the pre-scanned image at the point where the mouse is].

With the mouse over other very bright/white regions of the pre-scan, compare the numbers with the ‘pipette’ that was opened in 7c. If the numbers in the densitometer are higher overall (255 maximum), hold SHIFT and click on that part of the image (select with precision, looking at the densitometer). Another crosshair will appear on the pre-scan and an additional pipette will open. This is your new brightest highlight point. Disregard the pipette opened in 7c.

e. Find the highlight/shadow button in the SILVERFAST AI panel (The button looks like an eye dropper with a white triangle above and black triangle below). Click on the white triangle. The cursor will change to a white triangle.

f. Point the top of the white triangle at the center of the brightest highlight crosshair (as determined by 7c or 7d. Again, select with precision by watching the densitometer. When the numbers in the densitometer are almost the same as those in the highlight pipette, you’ve selected correctly). Click on this point. Glance at the histogram again and notice that the right hand triangle under the graph has moved.

8. Set the SHADOW point.
   a. If you moved the selection marquee in step 7b, move it back to include the entire image.
   b. repeat steps 7a-7d using the black half of the “show brightest or darkest point” button, and the black triangle on the dropper button.
   c. This sets the shadow point. Notice that the left hand triangle has moved in the histogram window.
d. Open histogram window. Enter the level/contrast adjustments in the scanning log (these are the numbers for the adjusted shadow, mid, and highlight markers, e.g. 27-0-155)

9. SCAN
   a. Move the selection marquee until it is just outside of the entire image. This will NOT change the highlight/shadow adjustments you just performed.
   b. Set the DPI to the setting needed for the scanning order. [600 dpi for original NWACC Morehouse project] Do this by typing it into the field next to the DPI button in the FRAME panel in the SILVERFAST AI window. Make sure that both scale windows [width and height] say 100% size.
   c. Click SCAN RGB (the annoyingly colorful button at the bottom of the SILVERFAST AI window).
   d. Wait for the scan to open in Photoshop.

10. QC on acquired scan
    a. When scan open in Photoshop, invert the image by pressing ctrl+I.
    b. Press the key ‘Z’ to select the zoom tool and click with the magnifying glass cursor [or] press ctrl + and ctrl ] to gradually zoom in to several highlight areas of the image (e.g. sky, if not blown out to complete white).
    c. Look for traces of magenta banding/striping. Open histogram Layers> New adjustment Layer> Levels. Look for a histogram that spreads out across the spectrum of the graph (note: if edges of negative, scratches, or hand-lettered text is included in image, the histogram may appear to slightly clip at the edges, or spike near the ends of the histogram. This is not a problem). Close histogram by pressing CANCEL in the histogram window.
    d. If no problems are observed, skip to step 11. If banding is observed, or if histogram is unacceptably compressed, close the scan without saving it, and reopen Silverfast. (File>Import>Silverfast).
    e. When Silverfast reopens, selection area and all adjustments will still be set for the image you are scanning (as long as you have not moved the negative on the scanning bed).
    f. If histogram problems were observed in 10.c, start over at step 4 (including RESETTING image alterations).
g. If banding problems were observed in 10.c - simply press Scan (WITHOUT altering selection area, highlight/shadow points, etc.) and restart at QC/step 10 once the rescan opens in Photoshop.

11. After the image opens in Photoshop, select FILE > SAVE AS > TIFF> and enter the filename [PH036_xxxx]. Save the image in the Scanning Work folder.

12. Complete metadata entry in the Scanning Log. Enter scan date, level/contrast adjustments, filename, initials, and scanner position if not already noted.

13. END / NEXT IMAGE. WHEN FINISHED SCANNING, TURN OFF THE SCANNER.
APPENDIX B. SIMPLE STEP-BY-STEP SCANNING DIRECTIONS
Digitization - Step by Step
software: Photoshop Elements  scanner: HP7115

1. open desktop folder named “Digitization Projects”
2. put photo in the scanner
3. open ‘Photoshop Elements’
4. From File menu choose Import ----> HP scanner
5. select the photo by ‘pulling up’ the lower right-hand corner until it ‘fits’ around the photo.
6. notice the size of the selection .. if the photo is at least 6 inches in both dimensions go to step 9
7. if the image is smaller than 6 inches in either dimension choose Resize from the menu.
8. change the size until both dimensions are over 6 inches then click OK
9. a new menu will open .. click Accept
10. when new window opens with the photograph in it, go to the File menu choose
    Save As .. choose to put the digital copy in the desktop folder ‘today’s scans’ then
    change name from Untitled to the photographs accession number + .tif .. then click
    Save
11. a new window ‘Tiff options’ will open choose IBMPC then click OK
12. close photo by clicking X in upper-right corner ..for additional photos go back to
to step 4 and repeat.
13. when the scanning session is over exit Photoshop Elements.
14. transfer all of the session’s scans (Tiffs) to a CD. check contents of the CD to be sure
    the Tiffs are there, then delete the copies which are in the desktop folder. write
date of the session on the CD in felt-tip permanent marker pen
15. Enter the name of the CD disc on the Photograph Digitization Record form in the
    space provided.

**If you do not know how to burn the scans** onto a CD leave the Tiffs you have made
on the computer in the scanning folder and tell the Scan Director.

The Scan Director is:
If the computer won’t do what you want it to do, don’t worry or panic. Notify the Scan Director either in person or leave a note by the computer.

The Scan Director will contact you about the problem and fix the computer and let you know what the problem was.
APPENDIX C. THE EASY 1 2 3 MANUAL (ELECTRONIC FORM)
The Easy 1 - 2 - 3 Guide to Digitization in Small Museums

Penelope Kelly

Introduction
Preparation
Equipment
Process

1. Scan
2. Save
3. Store

Utility
Copyright & Contact
Introduction

This webpage is part of my Master Degree project in Arts and Administration, Museum Studies emphasis. The content of the guide comes from my three years of experience in the digitization projects I initiated at the Springfield Museum in Springfield, Oregon. This museum is a typical small museum in that it is staffed in large part by volunteers unfamiliar with computer technology. This challenge was overcome by a combination of information and enthusiasm which produced a digitized photography collection and two electronic exhibits.

I am indebted to my colleagues Kathy Jensen, who was the Director of the Springfield Museum when these projects were produced, and Collection Manager Estelle McCafferty. I am grateful to them for their unfailing support and the inestimable value of their contributions to the projects.

The Easy 1 2 3 guide will teach you how to make digital copies of your historical photographs collection. Your museum staff will be able to digitize your collection with a minimum of funds and without staff trained in digitization procedures.

Penelope Kelly

******************************************************************************

Preparation

* Familiarize yourself with the contents of this website.

* Talk to your staff about the digitization project and ask for interested volunteers. Stress that they don’t need to be computer experts to help with the project.

* Assemble the equipment listed in the Equipment section.

* Print out each of the forms you will find in the Equipment section. Print the forms in a font size large enough for everyone associated with your project to read easily.
* Familiarize your project volunteers with the computer’s digitization desktop folder and its contents. (See the Equipment section)

* Arrange your photographic collection in sequential order by accession number. Although ‘out of order’ photographs can be integrated into a scanned collection your project will be MUCH easier if you take the time at the beginning to have all photographs in one place and in order.

* Establish who will ‘pull’ the photos as they are going to be scanned, and how they will be refiled. An In-Out tray by the computer is a simple way to organize the photographs for scanning and refiling.

* Determine who will act as the Scanning Director. This person should be technically knowledgeable and available to answer questions. Enter the Scanning Director’s name prominently in the Digitization Record Book which you will make according to the instructions in the Equipment section of this guide. Inform each scanning volunteer how to reach the Scanning Director. (Telephone, notes on the computer, e-mail) The Scanning Director should check the project periodically to be sure it is progressing in accordance with the Scanning Standards.

********************************************************************

**Equipment**

* **Computer** - with software on it which is able to save a scanned image as a TIFF (such as Photoshop™) *** You may not need to buy additional imaging software as many scanners come with suitable software installed. Read your scanner manual to determine if image manipulation software is present on the scanner.

* **Flatbed Scanner**

* **CD Burner**
* **CD-ROMs** - get good quality - not 'budget' quality - the size should be 600 MB or larger

* **Digitization Record Book** - This is the heart of the Easy 1 2 3 Guide

How to make the digitization book

1. Get a 3 ring loose-leaf notebook.

2. Print copies of each of the following forms in the amounts listed. Click on the name of the form to open it. Use the Back button of your browser (Netscape, Opera, etc.) to return to this page

   1. **Before You Scan** (print one copy)

   2. **Scanning Standards** (print one copy)

   3. **Photograph Digitization Form** (print multiple copies.
      Start with 10 copies and add more as you need them)

3. Put the printed copies of the forms in your 3-ring notebook

4. Your Digitization Record Book will also need to include **Step-by-Step** instructions which explain in detail how to use your particular scanner and software.

   The directions need to be unambiguous. Your staff should be able to digitize photographs by following your Step-by-Step form. Ask a volunteer to 'test' the instructions for you to be sure they 'work'.
The Easy 1 - 2 - 3 Guide to Digitization

Click here for an example of Step-by-Step directions. Please Note these instructions are only an example. You will need to develop instructions for your own equipment and software.

* Create a folder on the computer’s desktop. Name the folder ‘Digitization Projects’. The function of this folder is to make all of the digitization tools highly visible and convenient to find.

1. Within the ‘Digitization Projects’ folder create a ‘Shortcut’ (PC) or ‘Alias’ (Mac) for all the software and hardware needed to scan, save and store your Master images.

2. Also inside of the folder ‘Digitization Projects’ make a folder named ‘Today’s Scans’ - Each session’s scans will be stored in this folder before they are transferred to a CD.

************************************************

Process

* Digitizing a collection of historical photographs is a surprisingly simple process. Start at the beginning of your photograph collection and keep scanning photographs until you reach the end of your collection. Hardware and software vary but basically the process is the same no matter what kind of computer or flatbed scanner you may have.

1. Place a photograph in the scanner.

2. Scan the photograph and then tell the scanner to send the digital image to your computer.

3. Tell the computer to Save the digital copy.

4. Transfer saved images from the computer and Store them on
CD-ROMs

* Steps 2-4 are described in more detail in the following sections titled Scan, Save, and Store.

**********************************************************

1 Scan

The Digitization Record Book

* Place the Step-by-Step instructions and the Scanning Standards at the beginning of the Digitization Record Book. Go over the contents with each team member. Show them the forms and answer questions about the process. Tell them it is “Okay” to take the Step-by-Step sheet out of the record book and set it by the computer for reference.

* All information about each photograph scanned is recorded in the Digitization Record Book as each scan is being made. Two-person teams work well because one person can write in the record book while the other person runs the computer. If you have a volunteer who prefers to work alone that way works too.

* Faithfully follow the Scanning Standards. These standards produce high quality digital images and will enable even your non-technically oriented staff to feel comfortable that they are ‘doing it right’.

Scanner Settings

* Set the scanner’s default settings to True Color (or plain Color), 300 dpi resolution, 100% scale.

* Some scanners have settings for filters which will ‘correct’ the image automatically. Turn off those features - you want a straight scan. When you scan your photograph you are going to make an unaltered, authentic copy.

* Scan all photographs in True Color mode .. yes, even black &
white photographs. 
The reasons are that details can be ‘teased’ from color scans and one setting for all prints keeps the process efficiently simple.

* Scale - Photographs are easier to see if they are at least 6 inches by 6 inches. If you are working with pictures which are smaller than 6 by 6, such as picture postcards, I suggest you increase the size of the digital image. If you want to make a digital image which is larger than the original photographic print change the scale during the scanning process. Enlarging the scale at the scanner will produce a superior image over what you can achieve by enlarging the image later in image manipulation software (such as Photoshop®). Record the scale change in your Digitization Record Book.

 ****************************************

2 Save

* Save the digital image as an Unaltered, Uncompressed TIFF. (If you are curious, TIFF is an acronym for Tag(ged) Image File Format)

* Remember - Do not make any changes to the Master other than scale and/or ‘rotation’. For example, do not change contrast levels, ‘touchup’ blemishes, or make any type of color correction on the Master.

* Save the Master with the accession number of the original photograph. When you scan both sides of a photograph or postcard you will create two separate image files. Identify the backside of the image with the accession number of the original photograph plus a small ‘b’ to make it clear that the file image is the backside of another image.
For example:

If the original photograph's accession number is 1979.002.001 then the digital copy will be called 1979.002.001.tif on a Macintosh computer and the digital image of the back of the original will be titled 1979.002.001.b.tif

The PC computer's numbers will be 1979_002_001.tif and the backside will be 1979_002_001b.tif

* Save all of the scanned images from each session in the 'Today's Scans' folder within the Digitization Projects folder on the desktop. This means that each time (Session) that a group of photographs are scanned a new folder will need to be created. Title the folder the current date. (For example 3-08-05) You may have more than one dated folder waiting to be transferred to a CD.

*********************************

3 Store

* Transfer each session’s scans onto a CD. When the CD is full make a copy of the CD. Duplicating the CD allows you to keep one copy on site and the other in a safe place off site. Be sure to have instructions in your Step-by-Step form about how to use the CD burner. If someone on the scanning staff is not comfortable making CDs the digital Master images can be left in the desktop digitization folder until the Scanning Director can transfer the images to a CD.

* A CD will hold approximately 40 15MB Master images. It will probably take several scanning sessions to fill a CD. Staff should know how to ‘burn’ the CD in ‘Session Mode’ as opposed to burning the entire CD with only a few images. Have someone who understands this process write clear instructions and place these instructions in your Digitization Record Book.
* Write the disc number and date of each session on the CD with a permanent marker pen. The Photograph Digitization Form has spaces where the disc number and scan date are entered - matching these to the correct CD makes it easy to find a particular Master image.

* Digital Masters can be stored on external and internal hard drives or Zip Drives® but I specifically recommend CDs because CDs are inexpensive and most importantly, the images will be ‘locked’ on the CD - meaning that they can’t be accidentally changed or erased as they could be on the other storage media.

* Buy good quality CDs - this is NOT the place to watch the budget because Archive quality CDs only cost pennies more than questionable ‘economy’ CDs.

*********************************

Utility

* **Tiff images can be used for printing** on a variety of surfaces including clothing, stationery, postcards, and calendars. Many templates are available .. check on-line or at your local stationery store for ideas about how to use your images to promote your museum or to create unique items for your museum’s gift store.

* **Collection management** is an obvious use for your digital images. Are you using a commercial database such as ‘PastPerfect®’ software ? You can view TIFF images in PastPerfect® directly from your Master image CDs. Simply put the CD which has the image you want to view into the computer and 'point' the software to the CD. The Photograph Digitization Record will record the disc location of all of your Master Images. Since all the images will have a disc number associated with them you will be able to identify your image and the disc where it is stored even if your digital collection grows to hundreds of discs.

* **Research, promotion, and electronic exhibits**.
Remember! Your Master image is a TIFF image and unaltered however you will be able to make copies from your Master. Among the alterations you can make to the copies are the options to change the colors, alter the file format, or sharpen the images. You will be able to use copies of your Masters in ways limited only by imagination.

* Would you like more ideas on how to use your TIFF images? Write to me about your needs and ideas, I will be happy to help you ‘brainstorm’.

******************************************************************************

Copyright & Contact Information

This guide is covered by copyright law. You are encouraged to use it, quote it, and print out the forms to use in your museum or other noncommercial use. All rights reserved.

I believe you will find digitization surprisingly simple and a very rewarding way to expand access to your historical photographs collection. You are welcome to contact me if you have digitization questions.

Penelope Kelly

my e-mail address is pkelly@efn.org

In October 2004 I co-presented a talk on Digitization at the annual meeting of the Oregon Museum Association. This is a link to the presentation I developed for that meeting. The underlined text on the last page will return you to this page.
Before You Scan for the First Time

There a few simple forms in this book. Each of them has been carefully crafted to ensure that the digitization project is simple and effective.

Please read over each form and then add your name to the Scanning Staff list.

* All staff are expected to faithfully adhere to the Scanning Standards and to follow the Step-by-Step scanning directions.

If you encounter any problems with the computer or do not understand the scanning directions contact the Scanning Director before proceeding. In the event you can’t contact the Scanning Director stop for the day and leave the Scanning Director a note on the computer.

The Scanning Director is __________________________

to contact __________________________

You can take the Step-by-Step directions form out of the book and set it up by the computer so that you can refer to it as you work. Please replace the form in the book when you finish scanning.

Scanning Staff

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

Scanning Standards

The purpose of these standards is to produce an archive quality digital copy of a photographic print or a postcard. The archive digital copy is called the Master in this Guide.

Guard the integrity of the Master - Do not make any changes to the Master other than scale and/or ‘rotation’. For example, do not change contrast levels, ‘touch-up’ blemishes, or make any type of color correction on the Master.

If there is more than one copy of a photograph determine which is the original print and use it to make the Master.

Photographs - Always scan in True Color (not grayscale or black & white)

1. Scale: 100 %.

OR Enlarge scale over 100% if original is less than 6 inches X 6 inches. Increase scale until image is over 6 inches X 6 inches.

2. Resolution: 300 dpi

3. Scan both sides if there is significant text on back of a picture such as name, date, location, or narrative.

4. Title of digital Master copy
title front side with accession number
title back side with accession number plus letter b.
example: (front) 1979_006_010.tiff
(back) 1979_006_010b.tiff

**Postcards** - Scan both sides in True Color

1. Scale: scale up from 100% until the image is at least 6 inches X 6 inches

2. Resolution: 300 dpi

3. Titles of digital Master copy
   title front side with accession number
   title back side with accession number plus letter b.
   example: (front) 1979_006_010.tiff
   (back) 1979_006_010b.tiff
Photograph Digitization Form

Accession Number ___________________________________________ Disc ______

_____ negative ______ no negative

Description________________________________________________________________________________________________________

______________________________________________________________________________________________________________________

Condition of Photograph: Good ___ Poor ______

Comments________________________________________________________________________________________________________

Scanning information: Date scanned _______ Your Initials ______

_____ Color ______ Other (If Other, please enter the reason) ______________________________________________________________

Resolution _____ 300 dpi _______ Other dpi & Reason ______________________

Size of Original __________________

Scale ______ 100% other _________%

Size changed to_________________________________________
Accession Number _____________________________________________ Disc _________

_____negative ______no negative

Description_____________________________________________________________________________________________________

_____________________________________________________________________________________________________

_____________________________________________________________________________________________________

Condition of Photograph: Good ___ Poor _________

Comments_____________________________________________________________________________________________________

Scanning information: Date scanned _________ Your Initials _______

_____ Color _______Other (If Other, please enter the reason) ______________________________

Resolution _____ 300 dpi _________ Other dpi & Reason ________________________________

Size of Original _________________________

Scale ______ 100% other _________% 

Size changed to__________________________
## Digitization Step-by-Step

**Software:** Photoshop Elements

**Scanner:** HP7115

1. Put photo in the scanner

2. Open desktop folder named “Digitization Projects”

3. Open ‘Photoshop Elements’

4. From File menu choose Import ----> HP scanner

5. Select the photo by ‘pulling up’ the lower right-hand corner until it ‘fits’ around the photo.

6. Notice the size of the selection .. if the photo is at least 6 inches in both dimensions go to step 9

7. If the image is smaller than 6 inches in either dimension
choose Resize from the menu.

8. Change the size until both dimensions are over 6 inches then click OK

9. A new menu will open .. click Accept

10. When new window opens with the photograph in it, go to the File menu choose Save As .. choose to put the digital copy in the desktop folder ‘today’s scans’ then change name from Untitled to the photographs accession number + .tif .. then click Save

11. A new window ‘Tiff options’ will open choose IBMP C then click OK

12. Close photo by clicking X in upper-right corner .. for additional photos go back to step 4 and repeat.

13. When the scanning session is over exit Photoshop Elements.

14. Transfer all of the session’s scans (Tiffs) to a CD. check contents of the CD to be sure the Tiffs are there, then delete the copies which are in the desktop folder. write date of the session on the CD in felt-tip permanent marker pen

15. Enter the name of the CD disc on the Photograph Digitization Record form in the space provided.**If you do not know how to burn the scans onto a CD leave the Tiffs you have made on the computer in the scanning folder and tell the Scanning Director.
The Scanning Director is:

If the computer won’t do what you want it to do, don’t worry or panic. **Stop.** Take the photograph out of the scanner and replace it in its sleeve. Don't try to 'fix' the computer. Stop working, leave all the equipment on, and notify the Scanning Director or leave a note by the computer. The Scanning Director will contact you about the problem and fix the computer and let you know what the problem was.
APPENDIX D. THE EASY 1 2 3 MANUAL (PRINTED FORM)
BIBLIOGRAPHY


